


Table of Contents
1.0 About this User Manual

2.0 Introduction

3.0 Safety Information

4.0 Basic Operation

4.1 V150 Chassis Overview

4.1.1 Hard Buttons and Interfaces

4.1.2 Special Functions

4.1.3 Software Update Process

4.1.4 Touch-Screen Display

4.1.5 Battery

4.2 Home Menu and Navigation

4.2.1 Platform Screen Icons

5.0 Common Functions

5.1 Utilities

5.1.1 About

5.1.2 Screen Calibration

5.1.3 Bluetooth/WiFi Wiz

5.1.3.1 Bluetooth

5.1.3.2 WiFi Wiz

5.1.4 Standby Mode

5.1.5 Power

5.1.6 Backlight

5.1.7 Global Settings

5.1.8 Date and Time

5.1.9 LAN (USB adapt)

5.1.9.1 Setup

5.1.9.2 IP Connection Status

V150_Common_Functions_Manual_RevC00 Page 2 of 62



5.1.9.3 Ping

5.1.9.4 Trace Route

5.1.10 Remote Access

5.1.11 EZ Remote

5.1.12 Help

5.2 File Management

5.2.1 File Manager: Working with Saved Results, Profiles, Images

5.2.2 USB Memory Browser

5.2.3 Manage SD Card

5.3 Tools

5.3.1 Fiber Scope

5.3.1.1 The Importance of Fiber Connector Inspection

5.3.1.2 Connecting the Fiberscope

5.3.1.3 Fiberscope Setup

5.3.1.4 Analyze

5.3.1.5 Capture

5.3.1.6 Results

5.3.2 Optical Power Meter (OPM)

5.3.2.1 Setting Pass/Fail Limits

5.3.3 Data Card

5.3.4 Signature Pad

5.3.5 WiFi inSSIDer

5.3.6 OTDR Viewer

5.3.7 Browser

6.0 Certification and Declarations

7.0 About VeEX
Go back to top

V150_Common_Functions_Manual_RevC00 Page 3 of 62



1.0 General Information
This user manual is suitable for novice, intermediate, and experienced users and is intended to help use the features and
capabilities of VeEX products successfully. It is assumed that the user has basic computer experience and skills, and is familiar
with telecommunication and other concepts related to VeEX product usage, terminology, and safety. 

Every effort was made to ensure that the information contained in this user manual is accurate. Information is subject to change
without notice and we accept no responsibility for any errors or omissions. In case of discrepancy, the web version takes
precedence over any printed literature. The content in this manual may vary from the software version installed in the unit. For
condition of use and permission to use these materials for publication in other than the English language, contact VeEX, Inc. 

© Copyright VeEX, Inc. All rights reserved. VeEX, Sunrise Telecom, Digital Lightwave, Air Expert, CaLan, FaultScout, Fiberizer,
MPA, MTT, RXT, VeGrade, VeriPHY, and VeSion, among others, are trademarks or registered trademarks of VeEX, Inc. and/or its
affiliates in the USA and other countries. All trademarks or registered trademarks are the property of their respective companies. No
part of this document may be reproduced or transmitted electronically or otherwise without written permission from VeEX, Inc. 

This manual describes software and/or a device that uses software either developed by VeEX Inc. or licensed by VeEX, Inc. from
third parties. The software is confidential and proprietary of VeEX, Inc. The software is protected by copyright and contains trade
secrets of VeEX, Inc. or VeEX's licensors. The purchaser of this device and/or software, downloaded or embedded, agrees that it
has received a license solely to use the software as embedded in the device and/or provided by VeEX Inc., and to use it solely as
intended and described in this manual. The purchaser is prohibited from copying, reverse engineering, decompiling, or
disassembling the software.  

Go back to top Go back to TOC

1.1 Customer Support

For more technical resources, visit www.veexinc.com.

For assistance or questions related to the use of this product, call or e-mail our customer care department for customer support.
Before contacting our customer care department, have the product model, serial number, and software version ready. Please locate
the serial number on the back of the chassis. Please provide this number when contacting VeEX, Inc. customer care. 

Support hours may vary depending on the product.

Product Technical Support

Support is generally available 8:00 AM to 8:00 PM, Eastern Standard Time, Monday to Friday.
Phone: +1 510 651 0500
E-mail: customercare@veexinc.com

MPA Product Technical Support

Support is generally available 8:30 AM to 5:30 PM, Eastern Standard Time, Monday to Friday.
Phone: +1 877 929 4357
International: +1 727 475 1206
E-mail: serviceandsupport@veexinc.com

Go back to top Go back to TOC

1.2 Warranty

For warranty information on VeEX products, go to https://www.veexinc.com/Support/Warranty.

To activate the warranty, please register your product at https://www.veexinc.com/Support/ProductRegistration.

Go back to top Go back to TOC

1.3 Patent Information
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VeEX product hardware and software may be protected by one or more patents on file with the United States Patent Office. 

Go back to top Go back to TOC

1.4 Documentation Conventions

Icons used in this manual:

Marks a helpful tip (action or method), which can save time and improve
usability of the product.

Provides important information needed to use this product and avoid
missteps.

Cautions against and action or inactivity, which can hinder productivity.

Strongly warns against a condition, an action, or inactivity which can lead
to a health hazard, injury, equipment damage, data loss, and/or financial
losses.

Stop and read before continuing.

Go back to top Go back to TOC
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2.0 Introduction
The purpose of this manual is to document the common features available on all V150 series based products such as but not
inclusive of the following V150 chassis test sets:

WX150
CX310
MTTplus-522, MTTplus-523
FX100, FX150
MTX150

2.1 Product Specifications
The most recent product specifications can be downloaded from the product page of the VeEX website.

Go back to top Go back to TOC
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3.0 Safety Information

Safety precautions should be observed during all phases of operation of this instrument. The instrument has been designed to
ensure safe operation however please observe all safety markings and instructions. Do not operate the instrument in the presence
of flammable gases or fumes or any other combustible environment. VeEX Inc. assumes no liability for the customer's failure to
comply with safety precautions and requirements.

Optical Connectors

The test platform displays a laser warning icon when the laser source is active to alert the user about a potentially dangerous
situation. It is recommended to:

1. Deactivate the laser before connecting or disconnecting optical cables or patchcords.
2. Never look directly into an optical patchcord or an optical interface (e.g. CFP, CFP2, CFP4, QSFP+, SFP+, SFP, OTDR, LS,

VFL) while the laser is enabled. Even though optical transceivers are typically fitted with Class 1 lasers, which are considered
eye safe, optical radiation for an extended period can cause irreparable damage to the eyes.

3. Never use a fiber microscope to check the optical connectors when the laser source is active.

Electrical Connectors

Telephone lines may carry dangerous voltages. Always connect the electrical test ports to known test interfaces which carry low
level signals.

Safe Module Handling

While replacing test modules, all work on the open panel must be performed only by suitably qualified personnel who are familiar
with the dangers both to people and to the instrument itself.

Modules are not hot swappable. The platform must be turned off and unplugged from VAC mains when removing or inserting
test modules.
For safety and EMC (Electromagnetic Compatibility), empty module slots must be properly covered with blank panel covers.
Prevent foreign objects from entering the RXT, before, during and after module exchange or re-configuration process. They
could create short circuits or damage internal fans.
Always store test modules by themselves in individual ESD protected packaging (with no loose elements, like screws or
tools).

Lithium-ion Battery Precautions

Lithium-ion (Li-ion) battery packs are compact and offer high capacity and autonomy, which make them ideal for demanding
applications, like providing long lasting power to portable test equipment. For safety reasons, due to their high energy concentration,
these battery packs and products containing them must be used, charged, handled, and stored properly, according to the
manufacturer’s recommendations.

Li-ion battery packs contain individual Li-ion cells as well as battery monitoring and protection circuitry, sealed in their plastic
container that must not be disassembled or serviced.

The test set unit's battery pack is also fitted with a safety connector to prevent accidental short circuits and reverse polarity.

Always charge the unit's battery pack inside the test platform battery bay using the AC/DC adapter supplied by VeEX.
Do not charge or use the battery pack if any mechanical damage is suspected (shock, impact, puncture, crack, etc).
Do not continue charging the battery if it does not recharge within the expected charging time
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Storage: For long term storage, the battery pack should be stored at 20°C/68°F (room temperature), charged to about 30 to
50% of its capacity. Spare battery packs should be charged and used at least once a year to prevent over-discharge (rotate
them regularly).
It is recommended to charge and use battery packs at least every three months. Battery packs must not go without
recharging (reconditioning) for more than six months.
After extended storage, battery packs may reach a deep discharge state or enter into sleep mode. For safety reasons, Li-ion
batteries in deep discharge state may limit the initial charging current (pre-recharge) before starting their regular fast charging
cycle. The pre-charging state may take several hours.
Air transportation of Li-ion batteries is regulated by United Nations' International Air Transportation Association (IATA)
Dangerous Goods Regulations and by country-specific regulations. Please check local regulations and with common carriers
before shipping Li-ion battery packs or products containing relatively large Li-ion battery packs.

Electrical Connectors

Telephone lines may carry dangerous voltages. Always connect the electrical test ports to known test interfaces which carry low
level signals.

ESD: Electrostatic Discharge Sensitive Equipment

Test modules could be affected by electrostatic discharge. To minimize the risk of damage when
replacing or handling test modules, make sure to follow proper ESD procedures and dissipate any
electrostatic charge from your body and tools and use proper grounding gear.

Perform all work at a workplace that is protected against electrostatic build-up and discharging.
Never touch any exposed contacts, printed circuit boards or electronic components.
Always store test modules in ESD protected packaging.
Wear ESD protection and grounding gear when:

Inserting, extracting, or handling test modules.
Inserting or removing SFPs, XFPs, QSFPs, or CFPs from the platform.
Connecting or disconnecting cables from modules or platform.

Go back to top Go back to TOC

V150_Common_Functions_Manual_RevC00 Page 8 of 62



4.0 Basic Operation

4.1 V150 Chassis Overview

4.1.1 Hard Buttons and Interfaces

 Test port and touchscreen variations may exist between different models.

Hard Buttons

A. Save: Saves current test results in the unit's memory and provides automatic naming and time stamping function.
B. Power: Press for 2 seconds to turn the test set ON or OFF.
C. Home: Returns the screen to the home menu. Pressing the Home key for 3 seconds puts the unit ins sleep mode. Once in Sleep
Mode, press the Home key for 3 seconds to return to normal operation.

 This is not full power shutdown. (Sleep mode is not available on MTTplus units.)
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Standby/Sleep Mode
F. Side Buttons: Side buttons on the left and right side of the unit provide additional functionality such as revealing menus and

scrolling through table results.  Button functions vary depending on the product.

Side buttons on the left and right of the unit can reveal menus or other functions depending on the unit

Other Interfaces

D. LED: Power ON and battery charge LED indicator
E. Micro-B USB: Use an USB-A OTG cable (included with purchase) to connect a USB to the micro USB port. The port
supports memory drives and USB add-on devices such as fiberscopes. An optional OTG to Ethernet cable is also available
for network connection. 
G. Test port connector panel
H. Touch screen
I. Power jack

4.1.2 Special Functions

The buttons on the V150 platform provide multiple functions (may vary between products).
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Quick Guide

Power ON/OFF: Press and hold the red Power button (B) for about two seconds, until the test set emits one beep, to turn it ON. To turn the
test set OFF, press and hold the Power button (B) for about two seconds until the test set beeps twice, then wait for the power LED (D) to
turn OFF. It is suggested to wait for at least 10 seconds before turning the test set back ON.

Forced Power OFF: In the unlikely event that the test set becomes irresponsive or behaves improperly, user can press and hold the Power
button (B) for about six seconds to force the test set off. No results will be saved.

Standby Mode: First, release any active test application and then press and hold the Home button (C) for about three seconds to activate
the Sleep or Standby mode. Once activated, the power LED (D) will flash green, to indicate that the test set is in standby mode (the fans
may stay on for a while, until all electronics cool down). This mode is used to conserve battery when the test set is required to “boot up” and
be ready to test faster. 
While in Standby mode, users can quickly press the Home button to have a glance of the current standby time and remaining battery
charge. 
To bring the test set back to full operation, press the Home button (C) again for about three seconds.

Save Results: Press the blue Save button (A) on the front to SAVE current test results.

Home Menu: Press the green Home button (C) on the front to go back to the Main Menu. Tap on the red Exit (X) icon, on the screen, to go
back to the previous menu level.

Screen Capture: By pressing the Save and right slider buttons (A+F) simultaneously, users can store a picture of the current screen
(screenshot) in the File Manager. The test set will emit a confirmation beep/tone when the screen is captured. The images are named with
a date + time code. Go to the File Manager to manage, view or transfer captured screens (>Utilities >Files >Saved).

Touch Screen Calibration: In the rare event that the touch screen may become irresponsive, press the Save + Home buttons (A+C)
simultaneously to invoke the touch screen calibration procedure. Refer to the Screen Calibration section for more details.

Clean Software Install: With the test set OFF, press Save + Power buttons (A+B) simultaneously to initiate a clean software install from
an USB memory stick.  Refer to the Software Update Process section for more details.

All settings, test results and user data will be erased. Performing a backup to a USB memory stick is recommended
(>Utilities >File >Saved, select all and tap on the ‘To USB’ button)

Software Update: With the test set OFF, press Power + Home buttons (B+C) simultaneously to initiate a software update from an USB
memory stick.  Refer to the Software Update Process section for more details. Settings, test results and user data will be preserved.

4.1.3 Software Update Process

Download the latest software version from the Support > Software section on the VeEX Inc. website. From A-Z Product List, select the
product then view the Software section.

1. Unzip the downloaded file and copy the file ending in veex-arm.tar.gz to the root directory of a FAT32 USB flash drive.
2. Connect the AC adapter to the test set.
3. Turn off the test set and plug the USB into a USB to micro USB OTG adapter. Connect the OTG adapter to the test set's micro USB
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port.
4. At this point, it is possible to perform a clean or standard software update. Be sure to back up all data prior to performing a clean

software update as it will reformat the internal storage and erase all user settings and test results.

A clean software update will erase all user settings and saved results.
Back up all data prior to performing a clean software update.

Clean software update: Press and hold the Save and Power buttons simultaneously.
Standard software update: Press and hold the Home and the Power buttons simultaneously.
In both instances, press and hold the buttons for at least 3 seconds then release.

5. The unit will automatically locate and load the software file from the USB flash drive. Wait for the upgrade process to finish.
6. After the software upgrade is done, go to the Utilities > About menu to confirm the software version.

Software Version is displayed in the About section

Go back to top Go back to TOC

4.1.4 Touch-Screen Display

The LCD supports touch-screen operation. To operate the touch-screen, use the stylus located in the top cover to navigate the menus and
tabs. Please observe the following precautions:

Never use excessive pressure on the touch-screen as this may damage its functionality.
Never use sharp objects such as a pen, screwdriver etc. as this may damage the surface.
Clean the surface of the touch screen using a soft cloth and mild detergent only. Do not use alcohol.

Go back to top Go back to TOC

4.1.5 Battery

The V150 chassis is equipped with an intelligent Li-ion or Li-poly rechargeable battery pack, depending on the product, which is located in
the rear of the unit. Refer to the product data sheet for specific battery information related to the unit. The battery will be partially charged
upon delivery, so it is recommended to charge the battery fully before use. Please charge the battery at room temperature to preserve its
life and to obtain maximum charge. The battery is charged during operation provided the unit is connected to the AC Mains using the
supplied AC adapter. Removing the battery, while the unit is powered on is not recommended - this may result in damage. Charge the
battery by connecting the AC Main adapter to the power jack on the left side.

Go back to top Go back to TOC

4.2 Home Menu and Navigation

V150 home menu layouts vary slightly depending on the test set, but are generally arranged in this manner:
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WX150 Home Menu

Optical Test Set Home Menu

A. Test Applications

Available Test application availability depend on the

Active Test Application Icon

The Active Test Application icon indicates the test application in use on the V150 chassis platform.
In this example, WiFi is displayed for the WX150.

Background Test Application Icon

The Background Test Application icon opens up the Utilities menu.

B. Screen Icons

C. Test Application Menu
Use the icon for each item to access the corresponding menu interface.
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D. Function Keys
Depending on the test set series, function keys controlling the test in progress may be available. Tap on the arrow or push in with the
physical right shift button to reveal the them.

Pressing the Right Shift Button Reveals the Stop Scan Function Key on the WX150

Go back to top Go back to TOC

4.2.1 Platform Screen Icons

Platform Icons

File: Provides file storage information.

Exit: Return to the previous screen

Home: Return to the Home Menu

Active Test Application: Access to test applications or test application
menu which varies depending on the test set mode. WiFi, SLM, FIBER,
and OSA are some of the applications available.

Utilities Test Application: Opens the Utilities menu.

Shift Key: Serve the same function as the physical side buttons on the
sides of the unit. Tap to reveal icons and test function keys.

AC Charging: The unit is plugged into external AC power. Tap to see
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battery charge status.

Battery Charging: The unit is powered by the battery. Tap to see battery
charge status.

Fiberscope: Indicates that a fiberscope is connected to the unit. Tap the
icon to go to the Fiberscope application.

Go back to top Go back to TOC
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5.0 Common Functions

Tools tab

Depending on the test set series, it may be necessary to tap the Test Application icon to access the V150 platform settings menu.
Tap on the left Side Button or green arrow to reveal the following functions common to all VeEX test sets:

Utilities
Files
Tool

Go back to top Go back to TOC
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5.1 Utilities
The Utilities tab provides settings for the global parameters of the test set or platform (system settings).

Settings Menu

Go back to top Go back to TOC

5.1.1 About

This section provides information about the software version, serial number, and MAC address of the management port of the unit,
as well as a list of software licenses (optional test features) currently loaded in the test set.

Go back to top Go back to TOC

5.1.2 Screen Calibration

Screen calibration can be accessed from the Screen icon or by pressing the Save and Home physical buttons for 3 seconds, then
releasing.

Utility Settings - Screen Calibration

Follow the instructions and tap on the center of the five targets displayed at all four corners. A message displays when calibration is
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complete. If a mistake was made during the calibration process and the touch screen is still not working properly, perform the
calibration process once again and repeat the above procedure.

Go back to top Go back to TOC

5.1.3 Bluetooth/WiFi Wiz

5.1.3.1 Bluetooth

Built-in Bluetooth support offers wireless connectivity up to 10 meters (30 feet), providing an untethered connection between the
tester and other Bluetooth compatible devices such as a PCs and smart phones, enabling users to transfer test results and other
files.

Bluetooth Setup

A Bluetooth icon displayed on screen indicates the Bluetooth connectivity status. A grey icon indicates no Bluetooth
connectivity, while a green icon indicates a successful Bluetooth connection.

Devices

Bluetooth details will be displayed including the MAC address of the device and the last 4 digits of the test set serial #. The last 4
digits of the test set will be the pairing code between the unit and the external device.

Bluetooth - Devices Tab
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Bluetooth - Devices Tab

Bluetooth - Connection - Passcode

Go back to top Go back to TOC

Setup 

1. Press Scan to check for available Bluetooth devices. Once scanning is complete, a list of discovered Bluetooth devices will
be listed. Please ensure the peripheral device is set to Discoverable during Scanning and Pairing operation.

2. Press Pair BT to begin the pairing process. During the pairing operation, you will be prompted to enter a code on the
peripheral device (PC or Mobile Phone) in order to pair successfully. Enter the last 4 digits of the test set's serial number as
shown in the Connection tab.

3. Once paired, click the Services button at the bottom of the screen to check the service attributes. To upload test results via
Bluetooth, full data upload service will be required. 

Go back to top Go back to TOC

5.1.3.2 WiFi Wiz

The WiFi Wiz function can be used to provide WiFi connectivity to the unit. Depending on the unit’s model it supports 802.11 b/g/n
(2.4 GHz frequency band) connectivity or 802.11 a/b/g/n/ac (2.4 GHz and 5 GHz frequency bands) connectivity. Refer to the unit’s
specification sheet for details.

The WiFi Wiz function supports:

WEP, WPA, WPA2 Encryption
Scanning
SSID broadcasting and report
Signal Strength
IP Connection and Ping Test

Go back to top Go back to TOC

WiFi Procedure

Tap on the Scan tab to scan the list of available WiFi APs.

AP List

The following information is displayed for each AP:

SSID name of the AP
BSSID (MAC address) of the AP
AP's radio channel number
Lock symbol indicates if security is set on the AP (WEP, WPA or WPA2). 
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When the AP is unsecured, no lock symbol is displayed
Signal strength of the AP

Select one of the Access Points (AP) to start a connection. If the AP is locked, a network key is required to complete the connection.
The key can either be 10 characters or 26 characters.

If the user enters the wrong network key, the test set will still connect to the Access Point, but will not be able to
connect to the web or perform the Ping test.

Once selected, an Edit Settings function key appears.

Tap on Edit Settings or Connect AP to change the Encryption Type and enter the WiFi Key.

Encryption Type: Supported encryption types include WEP, WPA, and WPA2.
Password: Security phrase or password necessary to access SSID and network. Tap the Password field to enter the AP
password on the pop-up keypad.

ASCII formatting supported
The password/phrase can be hidden (Global Settings > Show Password > Yes/No)
Note: Passwords are case sensitive.

Hit Apply after selecting the Encryption Type and entering the Password. If the encryption menu was accessed via Edit Settings,
press Connect AP to connect to the AP. If the encryption menu was accessed via Connect AP, the test set will automatically
connect to the AP after hitting Apply.

WiFi Wiz - AP Encryption Settings

Connect

The Setup tab displays the Profile, ESSID, Encryption Type and Password.
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WiFi Wiz Connection Setup

Status

The Status Tab displays the following information on the connection:

Connection Status
ESSiD: Name connected to
BSSiD: MAC address of wireless router/device connected to
Channel: WiFi Channel # connected to
Encryption: Encryption type
Mode
Signal:

Radio signal level (dBm)
Link quality score

WiFi Wiz Connection Status

After a successful connection to the Access Point press Connect IP to obtain an IP address and access the additional IP tests like
Ping, Trace Route etc.
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WiFi Wiz Connect IP

AP Mode

In AP Mode, the unit emulates a WiFi access point/DHCP server and allows WiFi Clients (PC/Phone/Tablet) to connect to the unit.

Mode: Auto, Manual
Auto mode uses the default SSID and IP range
In Manual mode, the user can configure AP SSIDs and the IP range used by the DHCP server

SSID: Displays the default SSID or the manually configured SSID used by the AP
IP Address: Displays the default or manually configured IP address range used by the AP

Press Enable to enable the V150 AP Mode. After pressing enable, the V150 will broadcast its SSID, which any WiFi client device
can connect to.

Go back to top Go back to TOC

5.1.4 Standby Mode

Standby Mode Message

Standby Mode puts the unit to sleep, so that it wakes up faster than pressing Power to turn on the unit. To enter standby mode,
press and hold the Home key for 3 seconds until the unit beeps, then tap YES. The screen will be off, but the power LED will blink.
Press Home to view battery life and standby mode run time. Pressing and holding Home for 3 seconds again will return the unit to
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normal operation.

Go back to top Go back to TOC

5.1.5 Power

This section provides information about current power source and information about the battery gauge. Tap on the battery icon, on
the top bar, to bring battery charge and estimated autonomy information.

Utility Settings - Battery Power

Go back to top Go back to TOC

5.1.6 Backlight

This section provides backlight control of the unit.

Power: There are two settings -- one for Battery power and another for AC power.

The user has the option to select a timer to turn off the backlight if the unit is not in use. This function helps improve the
battery autonomy and preserve LCD life
To enable the timer, check "Turn off backlight if device is not used for" and with the drop-down menu, adjust the duration of
the idle time before the backlight is turned off.
Once the timer is active and the backlight turned off, any action on the test set (touch screen, keypad) will turn on the
backlight again.
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Backlight - Battery Power

Brightness: The user can select the brightness level for Battery and AC operation modes.

Backlight - Brightness

Go back to top Go back to TOC

5.1.7 Global Settings

General Setting

Language: An alternative language for the user interface.
Units: Measurement system (English - feet or Metric - meter).
Audible Alarm: When enabled, the test set's buzzer will sound (beep) when alarms and errors are being detected.
Show Password: Hides/unhides username and password information associated with FTP and related IP functions.
User Interface: The USA user interface version presents SONET/DSn application-oriented menus, while the International
setting is more open to all settings.
WiFi Auto Connect: After successfully connecting to a WiFi access point, the unit will attempt to automatically connect to the
same AP after the unit is turned off and turned back on.
RTU-410 (OTDR) Emulation Mode (FX150 only): Enables remote control of the FX150 OTDR using API commands.
OTG Port Mode: Configures the micro USB port for any USB device connected via an OTG cable. Later V150 models will
automatically detect and configure the OTG port to host or device mode.

Host: Enables the micro USB port to connect with USB devices such as a USB stick or Fiberscope. USB devices will
not be recognized if the OTG port is not set to Host mode.
Device: Enables the micro USB port to connect directly with a Windows® PC for the Share Results function.

Telnet: Allow or disallow telnet connection to the unit.
Share Results: Enables direct transfer of saved results from a V150 unit to a Windows PC. To directly transfer files, connect
the unit to a PC via an OTG cable, set the OTG port to Device mode and turn on Saved Results. If Share Results is OFF,
results are saved to the internal partition of the unit and can be transferred to a USB using the To USB function in the File
Manager. To directly transfer saved files to a PC, refer to the Share Results function.
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Utility Settings - General Setting

Storage Setting 

File Name Prefix: Tap on the box to enter the file name prefix using the pop up alphanumeric keypad.
Profile Deleting: Auto Delete or Prompt User.
Profile Saving: Auto Overwrite or Prompt User.
Result Saving: Manual or Prompt User.
Advanced Saving: On/Off. Allow users to add extra information to the results file to be uploaded to a centralized R300
Server. Requires Advanced Management Option.

Go back to top Go back to TOC

5.1.8 Date and Time

This screen allows the date and time to be set. Daylight savings are automatically enabled in the utility.

Date Setup

Go back to top Go back to TOC

5.1.9 LAN (USB Adapt)

Network parameters must be configured prior to performing any connection dependent measurements. An IP connection needs to
be established in order to perform a Ping or Trace Route test. For LAN connection, an external USB OTG adapter for 10/100BaseT
connectivity is required.
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Setup

5.1.9.1 Setup

Network configuration settings are available in the Setup menu. Additional fields will vary depending on Static or DHCP connection:

IP Address: Select from Static or DHCP
Static: If Static is selected, the user will manually enter the IP address parameters (local IP, Gateway IP and DNS
server IP)
DHCP: If DHCP is selected, the unit will obtain IP address parameters from the DHCP server

Local IP: IP address of the test set
Subnet: Enter the subnet mask
Gateway and DNS: ON or OFF

ON: If ON, enter the IP address of the Gateway and DNS server in Static mode, or use the IP address provided by the
DHCP server in DHCP mode
OFF: If OFF, no Gateway or DNS server will be used for the tests

Enter all parameters then press Connect to start the test.
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5.1.9.2 IP Connection Status

Ensure the Status is PASS before continuing with any IP tests. If the connection fails, go back to the setup screen to verify that the
parameters are entered correctly. Verify that the Ethernet cable is properly connected on the management port on the left hand side
of the unit.
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Status

DHCP: PASS indicates that an IP address has successfully been assigned.
IP: PASS indicates that the IP address assigned has been verified to be unique in the network.
Gateway: PASS indicates that the gateway IP address is valid.
DNS: PASS indicates that the DNS IP address is valid.
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5.1.9.3 Ping

The Ping Result provides the number of Sent, Received, Unreach, Missing, and the Round Trip delay.

Ping Testing

Ping is a popular computer network tool used to test whether a particular host is reachable across an IP network. A ping is
performed by sending an echo request or ICMP (Internet Control Message Protocol) to the echo response replies.

Ping Setup

Ping Setup

Profile: Delete, Save, Save as..., or Default.
Destination: Press the drop -down menu and enter the destination IP address or URL to ping.
Number of Pings: Enter the number of ping attempts (up to 10000)
that will be performed to reach the network device.

Note: If Continuous Ping is selected, the user is not required to enter the number of pings. The test set will
continuously ping the target host until the user presses Stop.

Length: Enter the length of the ICMP echo request packet transmitted.
Ping/Sec: Enter the Ping repetition rate (Ping/second).
Time Out: Time-to-Live (TTL) in milliseconds. Enter the maximum time allowed (in ms, up to 99999 ms) between an ICMP
ping and echo response.

Once the parameters are configured, press Start to begin the test.

Ping Results

Pressing Ping will take you to the Result tab and start the Ping test.
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Ping Result

Destination: Indicates the destination IP address.
Ping status: In Progress, PASS, or FAIL.
Sent, Received, Unreach, Missing: Number of pings sent, received, unreached or missing. A Ping is counted missing if no
response is received before timeout. A Ping is counted unreached if an echo response is received with host unreachable set.
PING also estimates the round-trip time in milliseconds

Current: The current time for a Ping request to be answered.
Average: The average time recorded for a Ping request to be answered.
Max: The maximum time recorded for a Ping request to be answered.
Min: The minimum time recorded for a Ping request to be answered.
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5.1.9.4 Trace Route

Trace Route is a common method used to find the route to the destination IP address or URL. It is often used to identify routing
problems and unreachable destinations. All the remote IP addresses and their response times are displayed indicating possible
network congestion points.

Trace Route - Setup

Trace Route Setup

The following setup selections are available:

Profile: Delete, Save, Save as..., Default. Select Default to recall a trace route file or create a new test
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Destination: Enter the IP address or URL of the network device to be detected
Time Out: Enter the maximum time allowed between an ICMP echo and response at each hop
Max Hop: Enter the maximum number of network devices the packet is allowed to transit

Once the parameters are configured, press Start to begin the test.

Trace Route - Results

Results

Hop: Order of the routers on the route
TTL: Time to reach each router on the route
Address: Address of each router on the route

If there is no response from a particular hop, an asterisk will be displayed.
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5.1.10 Remote Access

There are different ways to control or access the test set and the information it contains, from a local (LAN) or remote (WAN)
connected PC:

ReVeal PC software
VNC Client
EZ Remote
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ReVeal Software

This VeEX application allows the test set to connect, using the platform’s IP address. ReVeal CX300 is used for cable test sets,
ReVeal FX300 for fiber test sets, and ReVeal MTX for MTTplus or TX series WiFi and transport test sets. ReVeal offers the following
functions:

Test Profiles Management: Create, Edit, upload and download complex Ethernet and Fibre Channel test profiles (BERT,
Throughput, RFC2544, Y1564 SAM, Scan, IP, Ping/Trace, Packet Capture, etc)
Test Results Management: Download results from the test set, manage local test results (PC HDD), generate detailed test
reports, export to CSV or PDF, and print.
View software options, licenses, serial numbers, perform remote software updates

ReVeal is a Windows® application that can be downloaded free of charge from www.veexinc.com. 

Users are able to connect remotely from a desktop PC via ReVeal tool software or through Remote Access on the test set. To
proceed with remote access, make sure that remote control software is installed on the PC device. The user is able to configure the
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Profile, VNC Server Service, Web Service, VNC and Web passwords on the Remote Access page. Input the test set IP address and
specified user password when prompted by the software to initiate Remote Access.

For more information on using the ReVeal software, refer to the user manual on the VeEX website.
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Remote Access with VNC Server/Viewer:

The test set VNC service can be managed in >Utilities >Settings >More >Remote Access menu, to enable or disable the VNC
server and assign remote access passwords.

Super User Password: Allows remote VNC clients to view and control the user interface via mouse
Regular User Password: Allows remote VNC users (guests) to view what’s currently on the test set screen, but no
interactions with the GUI are allowed.

Although the test set VNC services allows multiple users to be connected simultaneously, it is a screen mirroring service, so all
users would be seeing and interacting with the same GUI. Such feature can certainly be used for training purposes, but it is not
recommended for multi-user or multi-test environments.

VNC clients, such as RealVNC®, are readily available for download for different platforms and form factors, including Windows®.
Mac OS®, Linux, iOS, Android.

VNC Service: Enable or disable the remote access to remote VNC clients running on PCs, Macs, tablets or smart phones.
VNC Super User Password: Defines the password for users allowed to control the test set via standard VNC clients
VNC Regular User Password: Defines the password given to users who are only allowed to view the test set current screen
via standard VNC clients, but not make any changes to test or test set.

After configuring these settings in the Remote Access menu, run VNC on the PC. A message box will prompt the user to enter a
Server number, which is the test set IP address. Enter the VNC Super/Regular password when prompted by the message box for a
password.

Remote Access

VNC Viewer - Enter Server Address
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VNC Viewer - Password Prompt
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5.1.11 EZ Remote

The EZ Remote functionality allows users to quickly and securely connect to VeEX test sets all over the world, without the need for
VPN, port forwarding or public IP addresses. This VeEX hosted service and user interface take care of all the complex tasks
required, and present users with a simple application. Connect online anytime anywhere with any computer, tablet or smartphone,
using standard web browser clients for screen-sharing, remote control and access to test results. Use it for remote control,
collaboration, technical support or training purposes.

The basic EZ Remote service is offered by VeEX free of charge. It provides public registration servers to help users and test sets
stablish remote sessions, without having to get IT departments involved. All you need is internet access for the test set and a remote
user. Feature location and functionality may vary from product to product.

 

VeEX’s EZ Remote provides:

Remote Control functionality to give users full control of remote test sets (screen mirroring and control).
Remote Access functionality allows users to View, Download, Rename, Delete, Export and Convert results (PDF).

Feature location and available functions may vary from product to product.

EZ Remote is considered a convenient on-demand service, for quick/temporary collaboration tasks. It should not
be used for long-term applications (VeEX offers other remote tools for long-term applications.)

Initiate an EZ Remote Session from the Test Set

Not all VeEX test sets may offer EZ Remote functionality. Make sure to upgrade to the latest versions available.

1. Use the >Utilities >Tools >IP Tools to connect the test set to a LAN using the RJ45 Ethernet management port, located on
the side of the unit (recommended), or use WiFi Wiz to connect to a WLAN (using built-in Wi-Fi or a compatible external USB
dongle). Make sure the test set gets a local IP address and that the LAN/WLAN provides access to the public internet (web).

2. Go to >Utilities >Settings >More >EZ Remote
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3. On the EZ Remote screen, set EZ Remote to Enabled, confirm the URL is ezremote.veexinc.net (without www.), and tap
on Apply to connect and establish a session with the EZ Remote server. 

 

4. Provide the resulting URL and Session ID to the intended remote user.
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5. You may continue to use the test set until a remote user logs in, then both will share control over the unit. Make sure the test
set remains connected to the LAN/WLAN/Internet and that the EZ remote session indicator at the bottom of the screen stays
green.

6. When finished, use the Stop button to terminate the EZ Remote session and disconnect from the server.

Connect to the Remote Test Set from a Computer

Establish a Remote Access Connection

EZ Remote provides two types of services:

Remote Control (screen and mouse/touch mirroring) to operate a test set from a different location.
Remote Platform Access to access information stored in the remote test set, such as Test Results, Profiles, User Manual,
Screen Captures (screen shots), information about the test set (Home) and its local IP address.

Although multiple users could simultaneously log-in to the same test set, they would be sharing the same
mirrored GUI image and mouse control. This is not recommended since it is equivalent to having multiple users
trying to operate one test set at the same time (also known as “mouse fight”).  Nonetheless, it may be effective for
training purposes with one or two extra users.

1. From a PC, Mac, Tablet or Smartphone launch an industry-standard Web Browser application and enter the URL
http://ezremote.veexinc.net. (without the www.). Enable pop-ups for your browswe and be sure to authorize access to the
site, if confirmation is requested by the browser or OS.
 

2. Enter the >Session ID provided, making sure not to confuse zeroes (0) with Os. Click on Search to find the target test set
and stablish a peer-to-peer connection.
 

V150_Common_Functions_Manual_RevC00 Page 33 of 62

http://ezremote.veexinc.net/#/


 
3. Once verified and connected, wait for the remote user interface to refresh. This may take a few seconds.

 

 
4. Depending on the type of test set used, shortcut buttons may be provided below the mirrored screen, allowing access to

functions provided by physical buttons on the instrument, such as Settings, Home, Save Test results. Click or tap on the
shortcut to activate it.
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Once the remote GUI appears, you can use the Remote Control tab to operate the test set in the same way you
would control a local unit from its touch screen.
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Save Test Results

To save the results of a test, from the remote computer, press the Save button below the screen image. Then use the pop-up
keypad and/or the PC keyboard to enter the file name and add any extra details (if Advanced Save is enabled).
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Access Remote Test Result Files

The Remote Platform Access tab provides links to access test results, test profiles, screen shots, the user manual and other
information stored in the test set.

 

A tab will open up for each selection made, allowing for quick access to each fuction.

Pofiles

Test Profiles are configurations saved by the user that can be retrieved and reapplied to the test set. For example, commonly used
configurations and test limits/threshold can be saved as test profiles, for different types of services.

 

Remote Control

Remote Control has been replaced by EZ Remote tab.

 

Manual

The feature provides access to the user manual that is built into the test set. In this application, the use of a local copy of the PDF
file is reccommended as the PDF client in the local computer is most likely faster than accessing the remote one and may offer

V150_Common_Functions_Manual_RevC00 Page 37 of 62



better tools and fuctions, including search capabilities. User manuals can be downloaded from the products’ page at
www.veexinc.com.

 

Results

Results list all the test results files currently stored in the remote test set. Users can View, Rename and Delete files stored in the
remote test set, as well as Download selected files to the local computer or convert them to PDF and download.

 

To open a test results file, select it from the list and tap on View.

 

 

Files can be downloaded by clicking on Download (original file format) or PDF.

 

Screen Shots

Pictures (PNG) taken of the screen can be accessed from this link and sub-tab. Pictures can be viewed or downloaded to the local
computer.

 

Screen captures can be made using the Lock button (Ï) on the test set or from the remote computer, using the links provided or the
respective F-key on the computer’s keyboard. The screen capture function can be enabled in >Utilities >Settings >Global >Save
Settings
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5.1.12 Help

The Help icon opens up the user manual section. Use the scroll bars, table of contents, and hyperlinks to navigate the
content.
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5.2 File Management

File Manager, Advanced
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5.2.1 File Manager: Working with Saved Results, Profiles, Images

The Saved File Manager (Files > Saved) displays all results stored in the test set. Use the check box to select a file to view, edit, or
export.

Table Sorting

Tap on any column header to sort the table in ascending or descending order by the column selected. Up and down arrow
keys indicate that the table is sorted in ascending and descending order respectively.
Tap on the filter icon in the heading to filter for specific test results stored on the unit
Column: Hides/shows selected columns
Show All: Shows all columns
Advanced: Search for a specific file using advanced search terms

Filtering the Mode Header

Viewing and Managing Files
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Selected files can be managed in the following ways:

View: View file
Del: Delete
Rename
U/L: Unlock or locks files to prevent accidental deletion
PDF: Converts all selected files: Requires FAT32 USB Memory stick

The File Management system offers backup To USB and restore From USB functions to preserve user data.

Enabling To USB and From USB Functions

To enable the To USB and From USB functions, insert a USB Memory stick (FAT32 file format) into a USB port on the side
of the unit.
Wait for the USB memory to be detected (the folder icon will change appearance with a green USB memory icon).

After the unit detects the USB memory stick, it’s now possible to download files to USB or restore files from USB.

Downloading Files To USB

1. Select the desired test results, test profiles, screen capture and protocol capture files to be saved, using the individual check
boxes. For a full backup, check the master check box on the header and all files will be marked.

2. Tap the To USB button to initiate the file transfer procedure and wait for the progress bar to finish. Original files won’t be
deleted from the test set.

3. When all files have been copied to the USB, tap the folder icon (top-right corner) and select Remove USB Drive to make
sure all cached data is transferred to the USB drive, especially when transferring small files.  

Bluetooth (BT) File Transfer requires a compatible USB dongle.
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5.2.2 USB Memory Browser

The USB tool can be found in the Utilities section, under Files > USB.

It provides users with basic memory stick management tools to browse and interact with content without the need of a PC:

Reload: Refreshes the USB stick info.
Delete: Erases the selected files or folders.
Up: Exits the current folder and moves up to a higher folder in the file tree hierarchy. The current folder structure is shown in
the top bar.
Open: Opens certain file types.

Use the USG cable Micro USB adapter to connect to the USB memory stick.

The following file types are supported:

HTML: Launches the browser to display its content
TXT: Launches a basic text viewer to display its content
PCAP: Launches the built-in Wireshark® protocol analyzer
MTIE: Launches the optional built-in Wander Analysis tool
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5.2.3 Manage SD Card

Internal SD Card Format

The Files > Manage tool under utilities provides SD card’s partition capacity information.

All the user information, such as test results, profiles, screenshots, protocol capture, etc., are stored in the Data partition (3). Use the
> Files > Saved > To USB backup utility or Delete function if the Data partition is nearly full.

The Format function is exclusively a maintenance tool. Use ONLY when instructed by a VeEX Customer Care representative. It
erases all the information stored in the test set.

The internal SD Card contains the System OS, all the Test Applications (Apps) and user’s data
Only the Data partition is accessible to users, through the test set’s functions
Do not remove or reformat the SD Card outside of the test set
The SD card can only be accessed by opening the test set
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5.3 Tools

Tools Home Menu

Available Tool applications depend on the product model.
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5.3.1 Fiber Scope

The Fiber Scope Inspector is an ideal tool for checking fiber optic connectors for dirt and end face quality. The handheld probe
design enables easy inspection of patch cords and difficult to reach bulkhead or patch panel connectors. Clear images are displayed
on the test sets for immediate analysis and can be saved for record keeping.

The Fiberscope test application can be used in conjunction with VeEX DI-1000 and VS-500 Fiber Scopes.

VS-500 Fiber Scope

DI-1000 Fiber Scope
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5.3.1.1 The Importance of Fiber Connector Inspection
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Dirty or scratched connectors introduce loss, increase ORL and/or damage other connectors (Loss becomes more critical at higher
data rates). End-face contamination is a leading cause of fiber link failures in data centers, corporate networks, MSOs and Telecom
environments.

Fiber Inspection Scopes provide a magnified image of the fiber optics connector’s End Face, focusing on the contact areas (prone to
loss or damage by mating). Images, visual inspection and automated tools are often used to grade the health and cleanliness of
connectors, after polishing or cleaning and before being used.
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5.3.1.2 Connecting the Fiberscope

VS500 and DI-1000 Fiber Inspection Scopes require the FiberScope Expert software option to be installed or activated.

Attach one end of the OTG cable to the microUSB port on the test set and the other end to the fiberscope USB port. Once the
fiberscope is detected, tap Yes in the pop-up window to enter the Fiberscope menu. The fiberscope menu can also be accessed at

any time from the Fiberscope icon .

Fiber Scope Detected Message

Alternatively, select the Test Application icon  > Utilities > Fiber Scope icon.

Fiber Scope, located in Tools > Advanced menu
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5.3.1.3 Fiberscope Setup

Fiberscope Setup menu

Captured patch cord image files are saved within a folder directory.

Scope mode: Select Local or Remote operation.
Auto Save: Disable, Autosave on Tap, or Auto Save after freeze. If Autosave option is enabled, the unit automatically saves
and creates the filename using Trace ID field content after the specified test function. The file location and name will display.
Selecting Ask Before Save brings up the Save menu with naming and comment options.

Autosave on Tap: In the capture tab, tap on the screen to automatically save the captured image. “Tap screen to save”
will appear to indicate that the feature is enabled.
Autosave after freeze: Automatically saves the captured image upon freezing the image.

Job ID, Cable ID, Fiber ID, and Trace ID are nested folders that store saved results. Folders are nested in the following order:
Job > Cable > Fiber > Trace. Tap on the blank fields to edit the names.
Increment: Increments the selected ID name if an Auto Save option is selected.

Saved image files can be retrieved from File Manager (see File Manager for details) or managed from the Results tab.
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5.3.1.4 Analyze
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To begin analyzing fiber connectors, select the connector profile and press the green Activate button which will turn the green
highlight to blue. For the VS-500, different stems are available for configuration. For identification purposes, a short stem is half an
inch long. Long stems are twice the length of a short stem. If a short stem is installed, select small. Select big for long stems.

VS-500 Stem Types

Stem Type Length

Long 1" (25.4mm)

Long 1" (25.4mm)

Short 0.5" (12.7mm)

 Currently, no IEC Analysis is available for MTP/MPO connectors.

Fiberscope Connection Instructions
When the DI-1000 or VS-500 fiberscopes are plugged into a USB, they will emit a blue LED. Turn the round focus knob to bring the
image into focus. The VS-500 and DI-1000 include the following buttons:

DI-1000 Controls
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VS-500 Controls

DI-1000 Controls

Image Capture Control: Freezes/unfreezes images.

VS-500 Controls

Image Capture Control: Freezes/unfreezes images.
Brightness Adjustment Controls: Lightens or darkens image contrast
Illumination LED: Turns the spot LED light on/off
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5.3.1.5 Capture Tab

Page 1 of the capture screen displays a live image of the connector face and features analysis and freeze tools.

Real time video of the connector face. Red contours indicate scratches and defects.

The soft buttons in the action bar (right side of the screen) do not indicate the current state or setting, they indicate the action that
would take place if pressed. For example, if “Analysis OFF” is tapped, the analysis function is turned OFF and the button displays
“Analysis ON”.

Freeze/Resume: Stops the real time video to produce a viewable static image.
Analysis On / OFF: Turn the Auto Analysis ON and OFF (software option). If turned ON, the test set automatically analyzes
the image in real time. If the markers get in the way of seeing the picture details, turn this feature OFF and perform manual
analysis.
Auto Freeze: Turn On and OFF the ability to automatically freeze the image when the image comes into focus. Once the
image is frozen, users can tap on the image to save it.
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Rectangles / Dots: Dots draw a red contour around scratches and defects. Rectangles highlight scratches and defects
without obstructing the view.
Shake: Turn On or OFF the ability to Auto Freeze and Analyze when the probe image is unsteady. Page 2 displays all
numeric results from defect and scratch events found for all four zones. Turn off shake for bulkhead inspection or loose fitting
connections.

Page 2 displays all numeric results from defect and scratch events found for all four zones.

 The scratches and defects table is included in the reports.

Measured scratches and defects compared with threshold criteria for each zone
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5.3.1.6 Results

Saved Files from Capture Screen

Results can be saved to the test set, exported to USB, or uploaded/downloaded to Fiberizer Cloud.

The directory displays the location of stored files. File management features are displayed on the right:

Load: Select an image file and tap Load to load the image onto the Capture tab.
Save: Manually creates a new folders structure and saves and names the image displayed in Capture.
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Modify: Modify files, folders, or Fiberizer Cloud settings. Options to Rename and Remove, files are available. Sign in to
Fiberizer Cloud from the Settings menu.
Pull: Downloads files from a Collection folder saved in your Fiberizer cloud account.
USB Export: Export results to USB and edit save options.

Exporting Results to USB

Exporting Results to USB

Attach an OTG to the microUSB port and a USB to the other end of the OTG. Tap USB Export. Export options include:

Export: Selected exports the selected file onto the USB. Everything exports all results from the directory.
Type: Tree places the saved file into a nested folder structure. Flat names the file according to the folder structure.

Select OK. A status screen will indicate whether the data transfer was successful.

Uploading Results to Fiberizer Cloud 

1. To push the results to Fiberizer Cloud, enable the network connection via the optional built-in WiFi or using OTG Ethernet
cable.

2. Log into the Fiberizer cloud account from Modify > Settings menu on the right side panel.

Fiberizer Cloud Log-in

3. Select the file or folder to sync with the account and then press Push to begin the sync process. There may be a delay with
0% activity but once files begin to sync, the status will change from 0% to 100%. At this time, the folder status will now
change from Push to Sync. 

Downloading Files with Fiberizer Cloud
Pulling downloads the directory collection from Fiberizer Cloud. You must be signed into Fiberizer Cloud to download files. This is
accessible from Modify > Settings.
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Download Window

Reports
The FiberScope test report can be viewed in HTML and PDF format.
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Fiber Scope Report in HTML
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5.3.2 Optical Power Meter (OPM)

Connecting an External OLTS Device

Insert the OPM dongle into the test set’s microUSB port and connect it to a supported Optical Light Test Source (OLTS) device
before launching this application. The unit will automatically detect and display the connected device. Tap Connect to proceed to
the external OPM menu or Use Internal to use the built-in OPM menu if it is supported by the test set.
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The Name of the External OLTS device is Displayed Once Detected

OPM Menu

Setup and Measurements

Wavelength: Matches the calibrated wavelength to the signal being measured.
Wave ID: Detects the incoming wavelength automatically. Use when operating the OLS in continuous wave (CW) mode with
or without Loop enabled.
dB/dBm: This switches between dB and dBm measurement units. A Green dB button shows absolute power level in dBm. A
Blue dB button measures relative power loss in dB. Set (Ref) and Enter (edit Ref) settings allow the user to set Reference,
Edit Reference and view measurements in three units: dBm, dB, and Watts.
Set: Sets the reference value for the current wavelength.
Enter: Edit current wavelength reference value.
Hold: Freeze measurement to the last power or loss reading on the screen. “HOLD” appears next to “Optical Power” when
tapped. Tap Hold again to unfreeze it.
Save: Loads current measured value into the Results table. The Results tab indicate how many new records have been
temporarily saved into memory. In manual IL test mode, the Save button must be used to capture each individual reading
(e.g. same fiber at different wavelengths) unless Loop is turned on. Select the Results tab to view all results in the table. This
is useful when measuring multiple fibers or testing one fiber with multiple wavelengths.
Zero: Recalibrates the OPM dark current to zero level. Used when measurement conditions change significantly or to re-
calibrate the OPM. Make sure the cover is shut on the OPM test port before tapping Zero. When in doubt, recalibrate prior to
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making any measurements, e.g, when testing in cold outdoor temperatures and then moving testing into a heated building.
OPM Server On: Remote control feature not currently supported.

If your device is equipped with a built-in clock, the saved measurement result will have a time stamp.

To permanently save the table of results, you must save into a test file.
Mode: Automatically designates the type of OPM: PM1 (+10 to -70dBm). No user selection available.

Results

Results can be saved to the test set, exported to USB, or uploaded to Fiberizer Cloud.

Results Management Menu

To view and save (enter) test results into the Results table:

1. Select the OPM tab. Verify the insertion loss (IL) values are acceptable, then tap Save to load values into the Result table.
The Results tab title shows how many fiber records have been saved in the format Results*-n NEW, where n is the number
of new records.

2. To view the active results table, select the Results tab.

Press Back to Save Results
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3. To permanently save the fiber record locally, press Back. The filename will default to date/time stamp unless a specific file
name is entered.

OPM results are saved, exported, and managed in the same way as results in the Fiber Scope application. Refer to Results in the
Fiber Scope section for more information.
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5.3.2.1 Setting Pass/Fail Limits

Whether measuring optical power or loss, there are always power input limits (saturation and Loss) or attenuation allowances that
determine whether the fiber cable meets the requirements for the desired application or network elements.

Power Limits (dBm): When check-box is ticked, users can enter the Minimum and Maximum power levels allowed for the
application (e.g. in line with the transceiver’s dynamic range). If the power reading falls beyond those limits, the power measurement
reading will turn red.

Loss Limits: Similar to power limits, user can set Minimum and Maximum amounts of optical power loss that are acceptable for the
application or specified for the cable or installation. User can simply specify the total amount of attenuation in dB. Alternatively user
can select the dB/km or dB/mi if the results are being compared against cable specifications. In this case, enter the length of the
cable under test for the test set to make the conversion.
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5.3.3 Data Card

To establish an IP connection using a data card, please make sure that the data card is connected on the USB port. Note that only
datacards provided by VeEX are supported and have the driver necessary for connection. The Data Card icon, as shown below, will
appear at the bottom of the screen.

Data Card - Setup

Press the Dial Up key.
In the IP Tools Setup menu, the Port will be displayed as "Datacard Port." The D for Data icon in the bar on the lower end of the

screen will have a red cross to show that datacard is not connected - .
Select the configuration parameters, then press Connect.
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Now that a connection has been established:

The D for Data in the icon turns green .
The connection details are displayed in the IP Tools Status tab (shown below)
It will automatically reconnect if the test set is powered off/on and you are in a good reception area
It will automatically reconnect if you enter a bad cell area and return to a good one
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5.3.4 Signature Pad

This feature enables a portion of the screen to be used as a signature pad. To begin, please make sure that the Advanced Saving
Global Storage Setting feature is on. To verify, see Utilities > Settings > Global > Storage Setting. If the Signature Pad is not
enabled, a warning message will appear.
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Signature Draw with a Stylus

Press Clear to erase all changes from the signature pad. Press Save to save the signature and the following Advanced Save
Settings can be configured in the pop-up window (as shown below):

Enter the desired Current Job ID, Current Account, Current Location, and Comments using the alphanumeric keypad
Locator: None
Type: None

Once the settings have been configured, press OK.
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The Signature and Advanced save setting fields will be added to all subsequent stored test results.

5.3.5 WiFi inSSIDer

WiFi inSSIDer Home

The WiFi InSSider supports only the 2.4 GHz frequency band or 2.4 GHz and 5 GHz frequency bands depending on the V150
product model (refer to product specifications for details). The home screen has tabs to display test results for both frequency bands
and also for graphical presentation of results for both.
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1. Tap the Scan button on the right side of the screen. After the scan is completed, the unit displays the list of access points
(AP) detected in the 2.4 GHz and 5 GHz bands. 

The following information is displayed for each AP:

SSID name of the AP
BSSID (MAC address) of the AP
802.11 protocol version supported by the AP
Max data rate supported by the AP
AP's radio channel number
Lock symbol indicates if security is set on the AP (WEP, WPA, or WPA2). 
When the AP is unsecured, no lock symbol is displayed
Signal strength of the AP

Access Points in the 5.0 GHZ spectrum can only be displayed if the VeEX USB Wifi adapter supports 802.11a/n or 802.11
a/n/ac. Refer to the USB Wifi adapter specifications.

2. Use the 2.4GHz GraphCH and 5.0GraphCH tabs to view the number of Access Points detected for each channel in the
2.4GHz and 5GH bands and the strength of the strongest AP's signal for each channel.

2.4GHZ Channel

3. Tap the Graph tab of the respective Channel to view the results in a graphical presentation.
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Graph

Use the Right/Left/Up/Down function keys or the arrow keys on the unit's keypad to navigate the graph and get additional
information for the access points. Detailed information for each Access Point includes:

SSID: name of the AP
AP's radio Channel number
Signal strength (dBm)
Number of co-channel: Number of APs using the same radio channel
Number of Overlapping APs: Number of APs using channels whose frequency band overlaps with the AP

Go back to top Go back to TOC

5.3.6 OTDR Viewer

This functionality allows the test platform to open and analyze standard OTDR .SOR files created by supported VeEX test sets. It
can also be used to control the wireless OPX BOX OTDR via Bluetooth or USB connection, offering full-featured OTDR functionality.

Refer to the the OTDR Series manual (FX150, FX300, MTTplus-410, RXT-4100, TX300s) for further details about its operation.
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5.3.7 Browser

The Browser application opens up a web browser which can be used to browse the internet or quickly verify Internet connectivity.

The built in web browser uses the WiFi/Ethernet IP WX150 doesn't have management port> connection.

An active IP connection can be established either through Ethernet, WiFi, or datacard ports.

Use the web browser's navigation bar to enter the name of the website you wish to reach.

Web Browser
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6.0 Certifications and Declarations

What is CE?

The CE marking is a mandatory European marking for certain product
groups to indicate conformity with the essential health and safety
requirements set out in European Directives. To permit the use of a CE
mark on a product, proof that the item meets the relevant requirements
must be documented.
Use of this logo implies that the unit conforms to requirements of
European Union and European Free Trade Association (EFTA). EN61010-
1

For a copy of the CE Declaration of Conformity relating to VeEX
products, please contact VeEX customer service.

RoHS Compliance

VeEX QUALITY AND ENVIRONMENTAL POLICY

Our quality and environmental policy is to limit and progressively
eliminate the use of hazardous substances and chemicals in the design and
manufacture of our products.

VeEX products are classified as Monitoring and Control Instruments
under Article 2, Section (1), Category 9 of the WEEE 2002/96/EC
Directive.

RoHS and WEEE Position Statement

The Council of the European Union and the European Parliament adopted
Directive 2002/95/EC (January 27, 2003), to Reduce the use of certain
Hazardous Substances (RoHS) in Electrical and Electronic Equipment,
and Directive 2002/96/EC on Waste Electrical and Electronics Equipment
(WEEE), with the purpose of reducing the environmental impact of waste
electrical and electronic equipment. Both were later recast by Directives
2011/65/EU and 2012/19/EU respectively. All VeEX products being
placed on the EU market conform with these directives.

Additional RoHS substance restrictions for the Monitoring and Control
Instruments were adopted by EU Directive 2015/863 (March 31, 2015).
These new restrictions will take effect from July 22, 2021. VeEX has
established a program to ensure that from July 22, 2021, all its products to
be sold and shipped into the EU market will conform with (EU) 2015/863.

VeEX Inc. is committed to comply with RoHS and WEEE Directives to
minimize the environmental impact of our products.

For more information about RoHS as it relates to VeEX Inc, go to the
VeEX web site at www.veexinc.com/RoHS
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7.0 About VeEX
VeEX Inc., a customer-oriented communications test and measurement company, develops innovative test and monitoring solutions
for next generation telecommunication networks and services. With a blend of advanced technologies and vast technical expertise,
VeEX products address all stages of network deployment, maintenance, field service turn-up, and integrate service verification
features across copper, fiber optics, CATV/DOCSIS, mobile 4G/5G backhaul and fronthaul, next generation transport network, Fibre
Channel, carrier & metro Ethernet technologies, WLAN and synchronization.

Visit us online at www.veexinc.com for the latest updates and additional documentation.

VeEX Incorporated
2827 Lakeview Court 
Fremont, CA 94538
USA
Tel: +1 510 651 0500
Fax: +1 510 651 0505

Customer Care

Tel: + 1 510 651 0500
Email: customercare@veexinc.com
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